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Next P*PCompAS meeting: Saturday, 7 March 2015
Learn about Acronis True Image 2015 from a webinar with Gene Barlow.
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Meeting 
Minutes
by Toni Logan, 

Secretary, 
P*PCompAS

As we March into spring I hope 
your thoughts will turn towards the 
security of good backup practices; 
hopefully before disaster strikes. 
Disaster recovery may be a topic 
we can look into as a future 
presentation, but for this month we 
will be showcasing a presentation 
on the latest version of Acronis True 
Image.

“Man is still the most 
extraordinary computer of all.” 
— John F. Kennedy ☺

The 7 February 2015 meeting 
was called to order by the 
President ,Cary Quinn, at 9 am. He 
welcomed everyone and reminded 
us that the coffee is generously 
donated by Laura at Starbucks at 
the Citadel Crossing. Coffee and 
donuts are free for first time guests 
and a donation for all others.

The minutes of the last meeting 
were approved as written in the 
newsletter. The President reported 
that the financial review has been 
completed and that the Board 
of Directors held a meeting on 
January 17.

OFFICER REPORTS

The Vice President had no 
report and neither did the Secretary.

Treasurer Dennis Conroy was 
not at the meeting. The President 
reported that the only major 
expenditures were a gift to the 
church and the annual volunteer’s 
luncheon. A budget is being worked 
on. Possible future expenditures 
were a gift to the church, a picnic 
or outing, or a free month of coffee 
and donuts.

APCUG Representative Joe 
Nuvolini reported that our dues 
have been paid. He also mentioned 
that he had sent the notice of an 
APCUG virtual conference to the 
members and also filed our annual 
tax return.

Newsletter Editor Greg Lenihan 
said that the deadline for the next 
newsletter is February 21.

Media Representative Ilene 
Steinkruger had nothing to report.

OLD BUSINESS: None

NEW BUSINESS

There were a couple of 
announcements. One was that 
there would be an electronic 
recycle at the Ent Credit Union at 
Woodmen and Campus Drive on 
Saturday, February 28, 2015. The 
second was made by Warren Hill. 
He reported that a computer lab in 
a grade school in Mexico was to be 
named for Bill and Barbara Everett. 
The school is near our sister city of 
Casa Nuevo Grande.

The next meeting will be on 
March 7, 2015. The business 
meeting was adjourned.

AROUND THE ROOM

The around-the-room 
discussion was varied as usual. 
Catch up on it via the audio on our 
website.

PROGRAM

Joe Nuvolini shared his 
experience, photos, and videos of 
CES at Las Vegas, Nevada. It was, 
as always, interesting, and we saw 
some new technology.

DRAWING

Bob Blackledge—Flashlight
Warren Hill—Computer monitor ☺



2 P*PCompAS

March 2015 Bits of Bytes

Officers
President: Cary Quinn
cary.quinn@gmail.com

Vice President: Harvey McMinn
harveys_homes@yahoo.com

Secretary: Toni Logan
bradtonilogan@gmail.com

Treasurer: Dennis Conroy
dennisconroy@comcast.net

Board of Directors
Toni Logan
Norm Miller
Bob Blackledge
Warren Hill
John Pearce

The Pikes Peak Computer Application Society newsletter is a monthly electronic publication. Any material contained within 
may be reproduced by a nonprofit user group, provided proper credit is given to the authors and this publication, and notification 
of publication is sent to the editor. Any opinions contained in this newsletter are made solely by the individual authors and do not 
necessarily reflect or represent the opinions of P*PCompAS, its officers, or the membership. P*PCompAS disclaims any liability for 
damages resulting from articles, opinions, statements, representations or warranties expressed or implied in this publication.

P*PCompas welcomes any comments, letters, or articles from members and non-members alike. Please send any articles to the 
editor (see last page for address). The editor reserves the right to reject, postpone, or edit for space, style, grammar, and clarity of 
any material submitted. 

Staff
APCUG Rep/Webmaster: Joe

Nuvolini
Editor: Greg Lenihan
Librarian: Paul Major
Membership: Ann Titus

Committees
Hospitality: Pat Krieger
Programs: Paul Godfrey, Toni 
    Logan, and Peter Rallis
Publicity: Harvey McMinn
Nominating: Vacant

PC Workshop
by Ann Titus, P*PCompAS

security essentials, password 
protection, downloads, 3rd party 
cookies

•	 Browsers (search engines)
•	 Service providers 
•	 Search engines
•	 E-Mail: Creating folders, setting 

safeguards; downloading 
attachments; creating 
attachments; saving e-mails

•	 Cloud Computing (Dropbox; 
Real Player Cloud, Google 
Cloud, One Drive)

•	 Library (Cybershelf; e-readers)
•	 Social media safeguards 

(Twitter, Facebook, Blogs)
•	 Maintenance and computer 

repair (updating; Malwarebytes; 
Ccleaner; backup and restore)

•	 Special applications:  Evernote, 
book publishing, Skype, 
LibreOffice, Grovo

MISCELLANEOUS:
•	 Managing files and folders
•	 How to create shortcuts
•	 Working with photos: Irfanview, 

Picasa, Photo Shop Elements, 
Pixlr.  How to set up and 
maintain a system for saving 
photos.

•	 How to create video 
presentations (Photo Story 3/
Windows Movie Maker)

•	 How to move photos from 
camera to folders

•	 How to publish a book
•	 How to find medical and safety 

equipment for seniors
•	 How to make screen shots 

(PrtScn, Snipping Tool)
•	 Burning CDs/DVDs

Where and when: First 
Wednesday of each month at the 
Colorado Springs Senior Center 
located at 1514 N. Hancock Avenue 
in the Catherine Smith Room in the 
NW corner of the center.  We meet 
from 9:30 am to 11:30 am.

Following the demise of the 
CoSnug computer classes in 2010, 
Marty White and I began offering 
a monthly opportunity for seniors 
to share their concerns, questions, 
and expertise with one another in a 
format of questions with answers, 
and demonstration followed by 
offerings of the latest information 
on computering. This is not a 
hands-on approach, because the 
participants do not have computers, 
but has seemed to fill a need for 
those wanting specific instruction 
on solving their computer problems. 
The Senior Center requires a $1.00 
fee per participant. Normally, there 
are about a dozen participants each 
month.

We emphasize the availability 
of free programs and have a motto 
that “There is no dumb question!” 
There is a lot of expertise within the 
group and everyone shares in the 
fun of discovering desired answers. 
We seem to cover a wide spectrum 
of questions which I will attempt to 
list at least in part.

INTERNET:
With all things on the Internet, 
we stress the need for caution 
in selections made during 
downloads—“Be careful what you 
click”
•	 Security:  Avast, Windows Continued on page 3



3P*PCompAS

March 2015Bits of Bytes

Programs Committee Meeting
by Harvey McMinn, P*PCompAS

    I spoke a bit about Sling TV at the 
February general meeting. I thought I 
would pass along a bit more information. 
Sling TV is a package of 15 TV channels 
including ESPY, ESPN2, TNT, TBS, Food 
Network, HGTV, Travel, Elf Rely, MAKER, 
Adult Swim, Cartoon Network, Disney, 
ABC Family, CNN, and Galveston. They 
are currently in negotiations to add AM 
and BBC World News. The package runs 
$20 per month with no contract. You can 
watch it anytime, anywhere, on your TV, 
tablet, smart phone, or computer. You 
need a device to watch it on your TV.

They are currently offering four 
special deals. If you prepay for three 
months you can get a free Amazon Fire 
TV Stick or Rock Streaming Stick. These 

plug into the HDMI jack on your 
TV. If you prepay for the same 
three months you can get $50 off 
Amazon Fire TV or Roku3. They 
also have some add-on packages 
for an additional $5/month each. 
They include Sports Extra, Kids 
Extra, and News & Info Extra. You 
do need to have a wireless router in 
your home as that is how the HDMI 
devices connect to the Internet. For 
more info, visit http://www.sling.
com. ☺

Nuggets from Nuvo
by Joe Nuvolini, P*PCompAS

The Programs Committee met 
after the February 7th membership 
meeting at the church. Committee 
members Toni Logan, Peter Rallis, 
Paul Godfrey, and Harvey McMinn 
met to discuss the topic of future 
presentations. President Cary 
Quinn was also in attendance.

John Pearce has volunteered 
to do a program in May by giving 

us an overview of Microsoft 
Windows 10.

The committee would like to ask 
the membership these questions:
1.	 What presentations would you 

be interested in?
2.	 Are there any members that 

would be interested in doing 
a mini presentation (15 or 
20+ minutes) on a program 
or application they are using? 

We would have three or four 
scheduled for a meeting.

3.	 Do any members know a 
friend or someone that would 
be able to do a presentation?

The committee requests that 
all members check with friends to 
see if they would be interested in 
coming to our meetings. Maybe 
we could generate more interest 
and ultimately more members. ☺

•	 How to backup and restore
•	 How to use System Restore 

(setting restore points, etc.)

FUN:  Each month we try to share 
some of the fun things that have 
appeared in our e-mails. 

There are lots of questions 
asked over and over about simple 
things like copy, cut, and paste; 
how to move files from one folder 
to another; simple questions about 
how to deal with photos. These are 
things which may seem obvious to 
many (especially young people), 
but to those who have not grown up 

with computers, pose problems.  At 
least for the foreseeable future, our 
generation may continue to need 
the support and direction. 

Questions not answered are 
my challenge to find answers and 
e-mail the results. I also e-mail any 
of the articles that the members of 
the group want, so they have them 
to use after the meeting. Finally, we 
do have a lot of fun in a very non-
threatening environment where we 
can learn together. We are happy to 
include anyone who is searching for 
answers to their specific computer 
questions or challenges. ☺

PC Workshop (Cont. from page 2) Tip: Google has a URL 
Shortener

Google has a convenient URL-
shortener service. Here’s how it 
works:

1.	 Select and copy your long 
URL into your clipboard.

2.	 Go to goo.gl
3.	 Paste your URL into the 

box where your cursor is 
positioned.

4.	 Click the Shorten URL 
button.

Copy (Ctrl+C) the already “selected” 
short URL to your clipboard. It looks 
like this: http://goo.gl/tjzuZW.  ☺

http://goo.gl/tjzuZW


4 P*PCompAS

March 2015 Bits of Bytes

Continued on page 5

Amazon Prime Streaming Media Takes on Netflix
 Published with permission from Ira Wilsker, Golden Triangle PC Club, columnist for The Examiner, Beaumont, TX

WEBSITES:
http://www.amazon.com/Cocked/dp/B00RSGI10U/
http://www.amazon.com/gp/help/customer/display.
html?nodeId=200444160
http://www.amazon.com/Prime-Instant-Video/b/ref=sv_
atv_0?_encoding=UTF8&node=2676882011
http://www.msn.com/en-us/money/technology/in-
amazon-netflix-battle-consumer-is-the-winner/ar-
AA8aEhj
http://finance.yahoo.com/news/analyst-says-amazon-
prime-reach-185905585.html
http://www.nasdaq.com/article/should-netflix-inc-and-
amazoncom-be-making-movies-cm438851
http://www.marketwatch.com/story/netflix-is-the-favorite-
in-streaming-market-2015-01-16
http://www.marketwatch.com/story/amazon-unveils-13-
new-shows-2015-01-06
http://www.nasdaq.com/article/overstockcom-is-no-
threat-to-netflix-or-amazoncom-cm438935
http://www.forbes.com/sites/
dorothypomerantz/2015/01/22/netflix-and-amazon-will-
have-a-harder-time-with-movies-than-they-did-with-tv/
money.cnn.com/2015/01/11/media/amazon-netflix-
golden-globes/index.html
https://gma.yahoo.com/blogs/abc-blogs/amazon-amzn-
movie-plans-shake-hollywood-154658496--abc-news-
deals.html
https://au.finance.yahoo.com/news/amazon-produce-
acquire-original-movies-230111020.html
https://en.wikipedia.org/wiki/Netflix
https://en.wikipedia.org/wiki/Amazon.com#Amazon_
Prime

As I type this, the extremely popular streaming media 
company Netflix is operating in over 40 countries, and has 
in excess of 50 million paid subscribers. Originally known 
for its mail-based DVD rental service, Netflix is currently 
the world leader in streaming media subscriptions. Once 
thought of in monopoly terms, Netflix is now facing serious 
competition from a multitude of sources including the online 
retailer Overstock.com, retailing megalith WalMart, and 
the marketing powerhouse of Amazon. While the lesser 
streaming media competitors (if anyone could ever consider 
Walmart a “lesser competitor”) have barely dented Netflix’ 
dominance in the streaming media market, Amazon’s growth 
as a direct competitor has been explosive.

According to Rich Tullo, the Director of Research for the 
old line Wall Street firm of Albert Fried & Company, “It looks 
to me like they are very close to or preparing to approach 45 
million U.S. [and UK] subs by the end of 2015. They could 

be pretty close to it now.” ... I think they’re 
probably really close to Netflix in terms of 
U.S. subs.” According to Tullo, “(Amazon) 
Prime subscribers are attracted to both the 
instant video content and the free two-day 
shipping, not one or the other. Once they 
see the platform, I think they like it,” Tullo 
said of those who accepted a trial offer. 
“I like it, it’s easy to use, and it’s got a full 
content offering. It’s very synergistic with 
their (Amazon’s) business.”

While most readers of this column are 
at least somewhat familiar with Amazon’s 
Prime services, many are not probably 
aware of the breadth and depth of the 
Prime offerings currently available for a 
$99 annual membership. Subscription 
discounts are available to students with 
an “edu” email address, new mothers 
(Amazon is the largest seller of diapers in 
the US), Prime subscriptions given as a 
gift, new Prime subscribers may qualify for 
a discount, and Prime may be available 
as a free affinity benefit from some of the 
premium credit card companies. One-
time free trials of Prime are also available 
from Amazon. While Netflix at about $8 
per month predominately provides the 
benefits of “SVOD” (Streaming Video on 
Demand), Amazon provides somewhat 
competitive streaming media, as well as 
many additional benefits not available to 
Netflix subscribers. The list of Amazon 
Prime benefits are extensive and includes 
free two-day shipping on most items sold 
by Amazon; Prime Instant Video, which 
includes over 40,000 titles of unlimited 
streaming of movies and TV; Prime Music, 
which includes unlimited, ad-free access 
to hundreds of Prime Playlists and more 
than a million songs for members; Prime 
Photos, secure unlimited photo storage 
on the Amazon Cloud Drive; Prime Pantry 
where members can purchase low priced 
grocery, household, and pet care items 
for a flat delivery fee of $5.99 for each 
Prime Pantry box; Prime Early Access, 
where bargain hunters can get 30 minute 
early access to select Lightning Deals on 
Amazon; Kindle Owners’ Lending Library 

http://www.amazon.com/gp/help/customer/display.html?nodeld=200444160
http://www.amazon.com/Prime-Instant-Video/b/ref=sv_atv_0?_encoding=UTF8&node=2676882011
http://www.forbes.com/sites/dorothypomerantz/2015/01/22/netflix-and-amazon-will-have-a-harder-time-with-movies-than-they-did-with-tv/money.cnn.com/2015/01/11/media/amazon-netfilx-golden-gloves/index.html
https://en.widipedia.org/wiki/Amazon.com#Amazon_Prime
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Continued on page 6

Amazon Streaming (Cont. from page 4)

where Prime members can borrow for free many 
of the otherwise paid Kindle e-books; Kindle 
First, where members can download a new book 
for free every month from the Kindle First picks; 
Membership Sharing, where Prime members 
may invite up to four eligible household members 
living at the same address to enjoy the shipping 
benefits of a Prime membership at no extra cost. 

While the majority of Amazon Prime 
members apparently join to get the free two day 
shipping benefits, the other major reason why 
(according to Tullo) Amazon Prime has tripled 
its membership in the last couple of years is its 
rapidly expanding library of streaming media. 
According to Amazon, “Prime members can 
watch thousands of movies and TV shows at no 
additional cost. You can instantly stream Prime 
Instant Video titles from your computer’s web 
browser, Fire phone, Fire TV, Fire Tablets, iOS 
devices, Android phones, and hundreds of other 
Internet-connected TVs, Blu-ray players, set-top-
boxes, and gaming consoles.” In addition to its 
paid Prime subscribers, Amazon also makes the 
streaming media available for free to those with 
a 30-day trial of Amazon Prime or Amazon Prime 
Instant Video.

Amazon’s current collection of movies and 
TV shows is smaller than that of Netflix, but 
Amazon is constantly increasing its selection of 
available media, with the clear intent of going 
head to head with Netflix. Amazon also offers 
one of the largest collections of streaming music 
in the industry, with millions of titles available 
for free to subscribers. In addition to licensing 
content from the Hollywood movie houses and 

national and international 
TV networks, Amazon also 
had a massive collection 
of movies, shows, and 
series created by the pay-
per-view and subscription 
media companies, such 
as HBO. Amazon, like 
Netflix, has started to 
finance the production 
of quality media and 
movies exclusively for its 
subscribers. According 
to a January 14 article 
published by MSN, 
“In Amazon, Netflix 
battle, consumer is the winner,” by Therese 
Poletti of Market Watch, “The video-streaming 
battle between Netflix and Amazon.com Inc. is 
intensifying, as both companies seek to become 
more like Hollywood producers, with Amazon 
upping the stakes this week in a big content 
deal. Amazon, fresh off two awards at the 
Golden Globes for its new show “Transparent,” 
announced a deal on Tuesday with filmmaker 
Woody Allen to write and direct his first television 
series.” In an article by the Motley Fool, dated 
January 31, “Amazon announced plans to launch 
a dozen original movies starting this year.” 

In addition to original movies, Amazon is 
also actively producing a large collection of 
new series, ten of which the pilots have been 
completed and are currently available to Amazon 
Prime and Prime Instant Video subscribers to 

The digerati arrived early 
on the third Saturday in 
February, knowing that the 
arrival of heavy snow would 
occur later in the day. That 
did not deter the happy mood 
and easy banter about all 
things techie and practical. 
Plus, many had coupons for a 
discount on breakfast.
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Amazon Streaming (Cont. from page 5)

view and evaluate. 
The ten recently 
released pilots, 
joining the stable 
of already released 
series, include 
several animated 
series for children 
(Buddy, Tech 
Detective; Sarah 
Solves It, and the 
Stinky and Dirty 
Show), a fully 
acted children’s 
series (Just Old 
Magic), and 
several comedy, 

action and drama series including The New 
Yorker Presents, Point of Honor, Man in the 
High Castle, Cocked, and Mad Dogs. Amazon 
Studios Vice President Roy Price is quoted on 
Amazon.com as saying, “Our first pilot season 
of 2015 brings some of the greatest storytellers 
in the business to Amazon customers with 
works of novelty and passion. We’re very 
excited by the shows and look forward to 
getting customers’ reactions.” I recently viewed 
“Cocked,” and found it totally entertaining 
and well done from an artistic view. Many 
other viewers of “Cocked” have had the same 
impression, as 1535 reviews of “Cocked” have 
been posted on Amazon, with 922 reviewers 
giving it 5 stars, and 352 giving it 4 stars, with 
the remaining 231 giving it lower scores, with an 
overall average of 4.3 out of 5 stars. I agree with 
the consensus of many of the reviewers who 
stated that “Cocked” included a good blend of 
both humor and drama.

In terms of accessibility, the Amazon Prime 
streaming media, including the videos and the 
million-plus streaming music titles, are available 
on almost all Internet connected devices, 
including computers, tablets, Amazon’s Fire 
devices, Apple and Android powered devices, 
set top streaming media boxes and sticks, and 
gaming consoles. Personally, I have watched 
a reasonable selection of Amazon’s “SVOD” 
(Streaming Video on Demand) directly on my 
desktop computer browser (mostly Firefox), 
my Android smart phone, and on my primary 
flat screen TV. On my smart phone I use the 
basic Amazon app to access my prime account, 
and then click on the menu icon on the top left 
corner of the screen to select the desired media 

types, and then choose the specific music or 
videos that I want. Any movies or TV shows with 
the “Prime” logo across their top left corner are 
available to Prime subscribers for free, while 
some of the new releases under the “Shop” 
categories, without displaying the Prime logo, 
are available for sale or rental. On my primary 
flat screen TV, I use an inexpensive but powerful 
Amazon Fire TV Stick, which plugs directly into 
an available HDMI port, to access the extensive 
Prime libraries, as well as content from several 
other streaming services. In my experience, the 
extensive collection of over 40,000 free movies 
and TV shows, as well as over a million free 
music titles was totally adequate for my needs.

While the streaming media and delivery 
services such as Netflix helped lead to the 
demise of much of the DVD rental industry, 
such as the disappearance of Blockbuster, 
the current technology of widely available 
broadband Internet along with the reasonably 
priced “SVOD” (Streaming Media on Demand) 
services, consumers have several good choices 
for digital entertainment. I have to agree 
with Therese Poletti, in her January 14 MSN 
story, “In Amazon, Netflix battle, consumer is 
the winner.” We all benefit from competition 
between strong competitors. Watch for even 
more upcoming enhancements from Amazon 
and Netflix, as they battle with each other 
for market share. Just as Netflix appeared 
from nowhere and defeated Blockbuster, and 
Amazon is now taking on Netflix, do not count 
out the upstart competitive services from 
Walmart, Overstock.com, Hulu Plus, and other 
services. We really do live in interesting times. 
☺

Joe Nuvolini giving a presentation on what he saw 
at the International CES in January.
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Music and Video Files: Modify Them
By Phil Sorrentino, Contributing Columnist, STUG, Florida, www.spcug.org, philsorr (at) yahoo.com

Continued on page 8

Music and video files that you 
produce with your video camera, 
or voice recorder, are not always 
exactly what you want. Now, I’m not 
suggesting that you can change the 
artistic quality of the file, but that 
you can change the file length or 
size to accommodate your particular 
needs. With either an audio or a 
video file, the particular file may be 
too long, or it may contain sections 
that are not needed. So, it would 
be nice to be able to cut off the 
beginning, the end, or remove a 
slice somewhere in between. I’m 
sure there are many other ways 
to accomplish these tasks, but I 
have found that Windows Movie 
Maker (to modify video files) and 
Audacity (to modify audio or music 
files) are good choices, and both 
of these software applications 
are free. Windows Movie Maker 
is provided by Microsoft and can 
be downloaded at www.windows.
microsoft.com/en-us/windows/
get-movie-maker-download, and 
Audacity is provided by Sourceforge 
and can be downloaded at www.
sourceforge.net/download.

A multi-media presentation, 
or “movie” as Movie Maker (and 
many other commercial packages) 
calls it, is a collection of pictures, 
videos, and music, organized as a 
movie, used to tell a story. It may 
be the story of your latest vacation, 
your last birthday, the last big 
holiday, your youngest grandchild, 
or a pictorial history of someone, 
something, or some organization. 
If you have appropriate pictures, 
videos, and music, Movie Maker 
can easily put them together 
to create a movie to express 
your particular point of view. So, 
obtaining the pictures, videos and 
music is usually the first step in 
producing your movie. Pictures 
are probably the easiest; you just 

review the pictures, improve their 
quality if needed, and then put them 
in an appropriate sequence. Videos 
are a little more difficult because 
they usually need to be shortened, 
and possibly have inappropriate 
sections removed. Music, or audio, 
is easy if you have good recordings, 
but sometimes you may want to 
remove certain portions, like bad 
scratches or pops, or a long lead-in 
or long lead-out. Or you might only 
want a few words out of a lengthy 
oration.

Movie Maker can be used as 
a tool for modifying video clips. 
(Once the video clips are the way 
you want, you can then add them 
to your movie.)  After opening 
Movie Maker, click “add videos and 
photos,” and navigate to the video 
clip that you want to modify. Select 
the video clip and it will be added 
as the only item in your movie. 
The video clip will be imported and 
shown as a series of video blocks. 
Now you can play your video clip 
using the Play and Pause buttons, 
and identify the pieces to be 
removed. Select “Edit,” under Video 
Tools, and you will see the “Split” 
tool. Move the Movie Cursor (the 
dark vertical bar) to the first point 
where you would like to split the 
video. If you are going to remove 

the beginning, move to the point 
where you would like the video 
to begin. Click the Split tool. This 
will create two videos, one before 
the split and one after the split. 
Right-click the video piece to be 
removed and select “Remove.” This 
will delete that piece of the video. 
Now you can move through the 
video and identify pieces to remove 
and pieces to keep. Just move the 
cursor to the locations to split the 
video and use the Split tool. Then 
remove the unwanted pieces and 
save the good piece as a new video 
with a new name. Usually you will 
find pieces to keep and pieces to 
remove interspersed. If you want to 
save many pieces, you will probably 
have to find a piece to save and 
delete everything else, and then 
start over with the original video 
and isolate the next piece and 
delete everything else. So it may be 
very tedious if you want to save a 
lot of small pieces from one larger 
video, but it will surely be worth 
the time and effort. Once you have 
video pieces, you can join them by 
starting with a “File>New” movie 
and adding the video pieces using 
“add videos and photos.” Put them 
in the proper sequence and add a 
“transition” in between so they will 
flow smoothly, then save it as a new 
video.

Audacity is an audio editor 
and recorder. Audacity is very 
comprehensive and can do many 
things. One of those things is that it 
can be used as a tool for modifying 
audio (sound or music) files. After 
opening Audacity, click File>Open 
and navigate to the audio clip that 

http://www.windows.microsoft.com/en-us/windows/get-movie-maker-download
http://www.windows.microsoft.com/en-us/windows/get-movie-maker-download
http://www.windows.microsoft.com/en-us/windows/get-movie-maker-download
http://www.sourceforge.net/download
http://www.sourceforge.net/download
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Music & Video (Cont. from page 7)

Continued on page 9

you want to modify. The audio 
clip will be imported and shown 
as a graph of the amplitude of the 
audio. (Both left and right channels 
will be displayed if the audio is in 
stereo). Now you can play your clip 
using the Play and Pause buttons 
and identify the pieces to be 
removed. No, or very low, volume 
periods will be indicated by just a 
horizontal line with no amplitude. 
The Audio Cursor can be placed on 
the recording by right-clicking on 
a point in the recording. A section 
of the recording can be selected 
by pressing the right mouse 

button while on the recording, and 
dragging the mouse to the end 
of the area to be selected. Then 
using the File>Export selection, 
the selected section can be saved 
as a new audio file with a new 
name. I found this tool very helpful 
in separating multiple cuts from 
an audio recording of a complete 
side of a vinyl recording (a record 
album for those of us over 40). 
I had converted my old vinyl 
recordings to .mp3 files, just before 
giving them away. To save time I 
converted the recordings a side at 
a time. So for each vinyl album I 
ended up with two .mp3 files, each 
about 20 to 25 minutes, and each 

having 12 to 16 cuts (songs) in 
each .mp3 file. So, the individual 
songs were separated by about 2 
seconds of silence (no amplitude), 
making them easy to identify, once 
you have listened to the cut using 
Audacity.

As you can see from these 
basic directions for modifying a 
video file with Movie Maker and an 
audio file with Audacity, the process 
is very similar, even though the 
displays look very different and the 
displayed file representations look 
very different. The results are very 
similar too; it’s a modified file that 
will be useful in your next movie 
making project. ☺

The Tip Corner—October 2014
By Bill Sheff, Lehigh Valley Computer Group, Pennsylvania, The LVCG Journal, www.lvcg.com, nsheff (at) aol.com

Let’s take a look at folders
When you highlight a folder and click on 

Organize you open a wealth of options. You can 
cut, copy, paste, rename, delete and a few other 
goodies. In this column we will take a look at the 
“Folder and Search options.”

When you click on the Folders and Search 
options another Pane opens up showing three 
tabs: General, View, and Search with the General 
tab highlighted.

The first choice is Browse folders where you 
can Open a folder in the same window or Open 
each folder in its own window.

If you click Open each folder in its own 
window, this will keep all open folders that you’re 
working with on the screen at the same time. The 
other option makes each newly opened folder 
replace the previous one.

While opening every folder in a separate 
window (and memory) will increase the stability 
of Windows this could slow your computers 
performance. I would suggest only using this 
setting if your computer frequently stops working 
and you want to minimize or troubleshoot problems. 

Clicking:  Opening files and folders with a 
single click allows you to use the same procedure 
that you use when going to a link on a webpage. 
Recommend keeping the standard double-click to 
open items (and single-click to select).

For the navigation pane, I guess that is up to 

you. I like just having the main folder open and I 
can then open any sub folder I want to get to.

Once you have made you choices you can 
click OK or Apply and your settings are now 
in use. Try them out. Remember you can click 
“Restore Defaults” to bring them back to the 
original settings.

Moving over to the Search tab, I usually 
just keep the defaults. One comment though is 
indexing. I think the jury is still out on that. On one 
hand, the searches are conducted much faster; on 
the other, indexing can slow down your computer. 
If you do not do a lot of searching I would suggest 
not indexing your drives. (Certain folders are 
indexed by default. To see what is being indexed 
on your computer, or to change what is being 
indexed go to Control Panel>Indexing Options.)

The most comprehensive tab is the View tab. 
Here you can do a lot of modifying to get your 
view exactly the way you want it. In most cases 
the choices you make are based upon some 
personal preference; however there are some 
considerations that should be made as you make 
up your mind. I have an X before the choices I 
have selected.

Some are the default selections and some 
are what I wanted. To pick what you want, put 
the mouse in the shaded box or circle and click. 
Clicking again removes the check.
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Some of the things you can do and what I have 
selected (with an X) are:

X  Always show icons, never thumbnails (Use this 
setting if thumbnail previews are slowing down your 
computer.)
    Always show menus (Use this setting if you want 
access to the classic menus, which are hidden by 
default.)
X  Display the icon on thumbnails (for easier access 
to the related program)
X  Display file size information in folder tips
     Display the full path in the title bar
    Hidden files and folders (Unless you have to work 
with Windows files you don’t need to show them.)
X  Don’t show hidden files, folders or drives
    Show hidden files, folders and drives
X  Hide empty drives in the Computer folder (This 
option doesn’t affect empty floppy disk drives, CD 
drives, or DVD drives.)
    Hide extensions for known file types (Windows by 
default has this checked, but you should uncheck it 
since this is a good way to ensure that files are not 
malicious software disguised as common files.)
X  Hide protected operating system files (This is 
recommended)
    Launch folder windows in a separate process
    Restore previous folder windows at logon 
(Automatically open the folders that you were using 
when you last shut down Windows whenever you 
start your computer. This helps preserve your work 
from session to session. But if you do many different 
things you may not want to check it.)
X  Show drive letters (Use this setting if you prefer to 
see only the friendly name of each drive.
X  Show encrypted or compressed NTFS files in 
color (Use this setting if you don’t want to see these 
files represented differently than other files on your 
computer.)
X  Show pop-up description for folder and desktop 
items 
X  Show preview handlers in preview pane (If 
you don’t want to show the contents of files in the 
preview pane leave it unchecked. Some believe that 
this setting could improve the performance of your 
computer.)
    Use check boxes to select items (This can be 
useful if it’s difficult for you to hold down the Ctrl key 
while clicking to select multiple files.)
X  Use Sharing Wizard (Recommended)
    When typing into list view (Automatically put the 
cursor in the search box when you start typing. This 
can be useful if you don’t often browse for files by 
typing the name of a file.)

X  Automatically type into the Search Box 
    Select the typed items in the view.

You can click and unclick anytime you 
want. You can also click to restore the defaults.

Don’t be afraid to play with the options and 
see if you like them. Once you are finished, 
clicking OK or Apply puts your choices into 
effect. 

To change the type of file that a folder can 
be optimized for, right-click the folder, click 
Properties, click the Customize tab, click a 
file type in the Optimize this folder for list, and 
then click OK. This will not work if you are in 
the Library. You can do the same thing while in 
the Organize pane by clicking on Properties. 
For example, the My Pictures folder is 
optimized for picture files. If you open this 
folder and change the view to Large Icons, you 
can apply the Large Icons view to every folder 
that’s optimized for pictures. I gave a tip in my 
September 2014 tip column about changing 
icons while in the Customize mode, but will 
repeat it here to make it all inclusive with the 
above suggestions.

Customize Your Folders
You can customize your folders to go 

from a plain folder icon to something that 
can represent what is inside the folder. It 
used to be easier, but now you have to go to 
Computers and click on the C: drive, then go 
to Users and then Documents. Right-click on 
any folder and click Options and then click on 
Customize.  A new pane opens up with lots 
of icons. Select the one you want, click Apply 
and then OK. The icon will now replace the old 
basic vanilla folder icon. If you don’t like the 
icon go back and click “restore original icon.”  
You can also select “choose a file to show as 
the icon.” 

Check the box next to “Choose A 
Background Picture” and click Next. From 
here you can choose from many different 
backgrounds, or pick one that you have 
stashed on your computer somewhere. You 
can also change the color of the text. ☺
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